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The DV-IP range of products consists of a number of video servers and decoder's. The following

describes the functionality of the DV-IP Viewer application which is supplied with any of the

video products in the DV-IP range; DV-IP Server, DV-IP ATM, DV-IP Retail, etc,

There are a number of Dedicated Micros user interfaces available, each with varying

functionality which can be specified in line with the system requirements.

The DV-IP Viewer 2 2 Software is a dedicated application that offers control of the many

features supported on the DV-IP.

This section details the DV-IP Viewer that is supplied with the unit, it will give information on:

•  How to access the applications

•  Explanation of the operational controls

•  Configuration where applicable

•  Functionality that can be achieved

The software is in two forms and can be installed from:

•  The CD ROM supplied with the unit

•  Directly from the DV-IP itself
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DV-IP Viewer

Note: The application that is supplied with the DV-IP also contains a Site Database Editor utility that can

allow a system to be built for each User and will be explained in this manual



It is recommended that the DV-IP Viewer 2 software be downloaded from the DV-IP unit itself;

this section will detail how this is achieved.

When the DV-IP unit has been configured and allocated an IP address it is possible to remotely

connect to the unit via the Ethernet network. To access and download the DV-IP Viewer

application carry out the following:

1. Connect to the DV-IP using the web interface, enter the IP address of the DV-IP unit in the 

address bar of the web interface.

2. From the Home page select the Software option

3. You will be presented with the software download screen

4. Select the setup.exe from 1. Main Viewer Software section

5. You will be asked if you want to run or save the file, it is recommended that if a dial up 

connection is being used for reliability select save. The following will show the file being 

Opened from it’s location
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Installing the DV-IP Viewer 2 Software

Note: At the time of issue the recommended (compatible) web applications are: 

Internet Explorer 6

Netscape Navigator 7.x



6. Select Run

7. Using the installation wizard follow the on screen prompts

8. Select Next

9. Enter the location where the software is to be saved, C:\Program Files\DV-IP (default). 

Selecting browse will allow you to search the drives available to you on your PC and 

network.

10. Select Next and the software installation process will commence

11. Select Finish to end the installation process. A short cut to launch the DV-IP Viewer 2 will

be 

automatically created on your desktop. The software can also be launched from Start -> 
Programs -> DVIPViewer2

12. The DV-IP Viewer 2 can be displayed in any of the supported languages; by default the 

display language will be English, to install the language of choice select the option from the 

2. Language Files section of the software download screen

13. Select Open, you will be prompted to select a location for the zip files to be extracted to

14. Leave the location as c:\ (default) and the files will be unzipped in the correct location. 

Select overwrite for any files that may already exist

15. Select Close to complete the file download, close the web interface

16. You will now be able to launch the DV-IP Viewer 2
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The DV-IP Viewer 2 is a dedicated software application that allows the Operator to take control

of most supported functions on the DV-IP.

A Viewer can connect to any DV-IP by entering the IP address of the server into the application

and selecting connect. All control of the live or recorded video can now be achieved.

The Viewer interface allows the operator to view and control live video, select and replay

recorded images, control audio connections and monitor events as they occur. It will display the

enabled cameras on the selected DV-IP unit, list logged alarms, VMD and system conditions

that are within the alarm log of the Server. Any of the associated images can be replayed by

double clicking the mouse on the relevant event in the list.

This sections details the functionality that can be achieved with the DV-IP Viewer and how to

configure the application to fit the User’s environment.
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DV-IP Viewer 2 Operation



Before connecting to a DV-IP and viewing video it is possible to set certain parameters on the

viewer to allow you to customise and enable the functions that are required for the system. This

feature allows each Operator to have a set of functions that is applicable to their requirements.

To configure the viewer carry out the following steps:

1. Select Tools -> Preferences, the configuration screen will be displayed

2. Select the Appearance tab.
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Idle/Timeout Image and Skin File

It is possible to adaptor the appearance of the viewer, this includes the

viewer skin, idle image (displayed when there is no connection to a DV-

IP device), time-out image (displayed when images have not been

received from the DV-IP within the specified time).

Border
When viewing multiple cameras from a DV-IP unit it is possible to

allocate a border around each video image, this is set in pixels

Image sizing

It is possible to configure the aspect ratio of the video image, this can be

selected to force the image to fill the image window or maintain the 4:3

aspect ratio.

Debug

It is possible to display a Debug window over the Viewer application,

this debug window contains information downloaded from the DV-IP unit

as the Viewer controls the device. This switches the menu option on or

off.

Note: This section may change with future releases of the DV-IP Viewer.

Image Header

Within the Viewer it is possible to display text information. It is possible

to set the colour and background colour of this text information. It is also

possible to switch between 12 hour and 24 hour mode.

VMD Display
The DV-IP supports Video Motion Detection (VMD), it is possible to

enable the Viewer to display the VMD areas for the displayed camera.

Configuring the DV-IP Viewer



3. Select the Network tab.

These settings relate to the network connection from the PC running the DV-IP Viewer

application.
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Bandwidth
If the remote connection is via a WAN it is possible to limit the bandwidth to ensure

the transmission and receipt of the video does not overload the Network.

Buffers

It is possible to allocate a network buffer, the options are 1, 2 or 3. The DV-IP

video server will buffer images and transmit these across the network. The buffer

option is related to the speed of the network that the images will be transmitted

across, if a slow network link was in use then the buffer should be set to 1 to

ensure efficient transmission of images. For fast connections the buffer can be set

to 3.

Timeout

If the DV-IP Viewer does not receive a response or video images from the selected

DV-IP device within a set time the viewer will automatically display the timeout

image.

Inline Audio 

It is possible to connect to a DV-IP and establish an audio connection in Live or

playback mode. The standard format for the audio link is UDP this is then

transmitted alongside the TCP video link. Selecting inline audio will ‘interleave’ the

audio and the video to create a single stream, this function is useful in applications

where routers will not allow UDP traffic to be transmitted across a network.



4. Select the Telemetry tab

This option allows how the telemetry is controlled to be adapted to best suit the Operator.
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PTZ Control

It is possible to control PTZ cameras connected to the DV-IP device from the DV-IP

Viewer. The control is either via on screen buttons for PTZ functionality or alternatively

it is possible to click within the image to move the the cameras.

Store Preset

This will allow the Operator to move the PTZ/dome camera to a position and store this

as a preset. The camera can then easily be moved to this position by selected the

corresponding preset number.



5. Select the File tab

Within the application it is possible to create a site database that contains all details on all the

units that can be accessed and controlled by the relevant Operator. This highlights where the

site files are to be stored.

6. Select the MPEG4 Support tab
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MPEG4 Button

The DV-IP devices can stream real time live video as MPEG4 images. Enabling the

display button allows the Operator to switch between viewing either MJPEG and

MPEG4 images.

Append Strings
This section is for advanced configuration and it is recommended that only Engineers

with experience of appending MPEG4 images configure this section.



7. Select the Events & Alarm tab

The DV-IP unit supports an event database, this information can be downloaded from the DV-IP

unit to the Viewer. This information can then be viewed by the Administrator/Operator.
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Event List This allows the maximum number of events that are to be displayed in a single page.

Playback Option
It is possible to define the mode that the Viewer will automatically be switched when an

event is selected, the options are: Play, Pause, Fast Forward or Fast Rewind.

Pre-Alarm Seconds - It is possible to identify a set period of time prior to the event that will

be displayed when the event is selected from the Event List. This allows the Operator to

see the build up to the incident.



Site DataBase Editor

The Site Database Editor utility is part of the DV-IP Viewing application and allows a site

structure to be created for each Operator station.

Configuring the Site Database gives the Operator the option to simply select a DV-IP device

from a site tree to gain control of the unit.

To create a database, select Tools -> Site Db Editor, you will be presented with the database

configuration screen

Site Details

1. To create a new site select the New Folder          option. You can now enter the information 

for the DV-IP into the Site Details page.
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Device Type

This identifies the device which is being added to the site database, the options are:

Image Server - video server device

Remote PC - For future expansion

Display Server - video decoder device

Name
This is the name of the DV-IP device, this will already be configured on the Server and

should be of some significance for the Operator

IP/URL This is the IP address or URL of the DV-IP Image Server

Site ID

This is the information that will be displayed in the DV-IP Viewer 2 site tree and it is

recommended that the Site ID be the same as the Name already allocated to the Sever

(see above)

Site Plan
It is possible to allocate a line diagram (not interactive) of the site that is being monitored by

the DV-IP. This is a useful feature when the Operator is responsible for multiple locations
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Site Text
This allows information that is relevant to the site that is being monitored to be instantly

available within the Viewer, for example the contact details of the site manager

User ID

This is the user ID that has been set on the DV-IP. If this is left blank within this screen

a prompt will appear asking for the user ID to be entered when a connection is made to

the DV-IP

Password

This is the password that has been set on the DV-IP. If this is left blank within this

screen a prompt will appear asking for the password to be entered when a connection is

made to the DV-IP

Image Format
The DV-IP can transmit images in live mode as either MPEG4 or MJPEG, this will select

the initial image format when making a connection to this DV-IP device

Bandwidth Limit

If a limit has been set on the network for the available bandwidth for video then this can

be reflected in the Viewer. Entering the limit will ensure that the link between the Viewer

and the DV-IP does not exceed the allocated bandwidth set

WAN Mode

For network links that are less than 128Kbits/s (16 Kbytes/s) select the WAN option to

guarantee a smooth camera selection over a low speed link.

Note: For lower bandwidth connections it is recommended that Medium resolution

should be selected, this will re-compress the video by a half during replay

On connection show

camera

If a specific camera is to be automatically displayed when the Viewer connects to a

particular server this can be identified within this section.

Relay Mode

There are two options Single or Multi

Single – Sets the system to only allow a single relay to be selected at any one time

Multi – Sets the system to allow multiple relays to be selected at the same time

Live Image Res
It is possible to identify the resolution of the image that will automatically selected for

Live mode when connecting to the DV-IP.

REPLAY Image Res
It is possible to identify the resolution of the image that will automatically selected for

playback mode when connecting to the DV-IP.

Display Mode

When making an connection from the DV-IP Viewer it is possible to identify a display

mode that will be automatically selected on connection to the unit, the options available

are Full, 4 Way, 9 Way and 16 Way

Codec Addr

It is possible to display video from the DV-IP video server on a CCTV monitor using a

DV-IP Decoder. A connection between the video server and decoder can be

automatically created when the DV-IP Viewer connects to the video server, enter the IP

address of the DV-IP Decoder that the images will be sent to

Codec Monitor
The DV-IP Decoder supports up to five monitor outputs, select the monitor output the

image will be routed to

Persistent If the connection is to be permanently established enabled the persistent link option



Relays

This section is for future expansion.

2. Select the Relay tab.

FTP/Backup

This tab allows the Administrator to identify the folders that will be downloaded from the DV-IP.

The default settings will ensure that any file that can be edited for configuration of the unit will be

downloaded.

As there is sufficient capacity on the DV-IP it is possible to store files on the hard disk along with

the configuration files. This feature allows site Administrators to save site information in a single

location that can be accessed from any point on the network, this could allow Installer's to

access information relevant to the site information from any location.
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Header This is the title that will be shown on the DV-IP Viewer 2 for the associated relay buttons

Enabled Each relay output can be enabled individually

Text
This text will be displayed within the DV-IP Viewer 2 and should have some significance

to the control

URL Not currently supported



3. Select the FTP/Backup tab
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FTP
This identifies the FTP username and password as previously configured on the

DV-IP – default is dm and ftp

Default type of backup

It is possible to enable/disable the three options; Configuration files, Web pages

and Application binary files and Log files. Disable the files that are not of interest

– default all options are enabled

Server path of Configuration

files

This identifies the path on the DV-IP where the configuration files are saved and

ensures all the necessary files are downloaded – default

app_drive\etc;app_drive\frm_data

Server path of log files
This identifies the path on the DV-IP where the log files are saved and ensures

all the necessary files are downloaded – default data_drive\logs

Server path of web pages and

Application files

This identifies the path on the DV-IP where the web pages and application files

are saved and ensures all the necessary files are downloaded -

app_drive\bin;web_drive\webpages;web_drive\frmpages

Max attempts to connect to site
This allows the maximum number of attempts to connect to the site to be

identified 

Maximum attempts to download

to each file

This allows the maximum number of attempts to download to each file to be

identified



Debug

The Debug option allows strings to be tagged on when requesting MPEG4 video. It is

recommended that Engineers with experience of MPEG4 video should configure this section

only.

4. Select the Debug tab
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Note: This tab is not available when Remote PC option is selected. This option may alter with future

releases of the DV-IP Viewer.



The DV-IP Viewer allows the Operator to control the functionality supported on the DV-IP

devices. The Operator controls within the Viewer are described within this section, this will be

separated into:

Connecting to the DV-IP unit via the Viewer

Common controls - available in both Live and Playback mode.

Live mode only - available only in Live mode.

Playback mode only - available only when reviewing recorded video.

Miscellaneous - additional functions that are not related to the operation mode.

Connecting to a DV-IP video server

To connect to a DV-IP device:

1. Enter the IP address or URL of the unit in the address section of the viewer, or if a site

database has been created select the relevant unit from the site tree. If the, address section 

is used the last 10 addresses are saved and can be accessed by clicking on the      button,

the saved address will be displayed.

2. Select the Connect button, it may take several seconds to make the connection the time 

period will be dependant on the network connection.
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DV-IP Viewer Controls



Common Controls

It is possible view live video or playback recorded video. The functionality (buttons) available in

both the Live and Playback mode are described below.

Camera Selection

The camera selection buttons are used to view any of the video inputs on the DV-IP device in

Live or Playback mode. 

These keys will be active for the cameras that have been enabled on the unit itself or where

recorded images are available for the corresponding input; any ‘greyed out’ camera buttons

shows that either the video input is not enabled or there are no associated video recordings.

Selecting one of the camera keys will display the video images in the selected display segment.

Display Mode

The DV-IP Viewer supports multiscreen viewing to allow numerous video images to be viewed

simultaneously. The display option can be selected from the drop down list. Images in Live and

Playback mode can be viewed in any multiscreen format.
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Single
A single video image of the selected camera will be displayed in live or playback mode. If

selected the last camera selected will be displayed.

Quad

A quad display will show the camera selected and the next three sequential (enabled)

video inputs, e.g. cameras 4, 5, 6, 7. If the sequential video inputs are not enabled then a

blank screen will be displayed in live or playback mode.

Instead of displaying sequential images it is possible to select which camera is to be

viewed in each segment. Click on a segment to highlight it and press the corresponding

camera button to be displayed.

Note: If the DV-IP Server has been configured to identify camera failure a Camera Fail Image will be

displayed on the relevant input, this is a colour chart with vertical bars.

Note: Refer to Appendix A for full details on the display options available.



Resolution Selection

It is possible to select the resolution of the image being viewed (Live and Playback), this feature

is useful when a slow speed link is being utilised for remote monitoring, and reducing the

resolution will reduce the amount of information that is being transmitted from the DV-IP device.

The settings for actual resolutions which corresponds to the options available (High, Medium,

Low) are configured with the Camera Set-up page of the DV-IP device; these settings include

the resolution and file size which will be associated with the resolution buttons.

High resolution is the optimum video image that will have a set resolution and files

size associated – Live and Playback mode

Medium is a low quality video stream that is sending less information with a reduced

file size – Live and playback mode

Low is the lowest video quality and has a low file size allocated, this would be the

most appropriate option when utilising slow speed network links – Live mode only
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Note: The DV-IP device is able to re-compress recorded images during the playback process; this will

reduce the size of the video image when using a slow remote link.

Note: If more than one user accesses the Live web page it is possible to have the same image being

viewed at different resolutions.

Multiscreen

Up to a 16 Way view can be selected in a number of variants, allowing all enabled images

to be displayed simultaneously.

It is possible to identify where video inputs are to be viewed within the multiscreen, select

the relevant segment (double click on the segment) and press the corresponding camera

button for the live or recorded image to be displayed in that segment.

Picture in Picture

It is possible to display a picture as an overlay of the main picture, this can be a single or

quad display. When a picture in picture display is select the main window will display the

last selected camera and the sequential image(s) will be displayed within the inlay section.

Instead of displaying sequential images it is possible to select which camera is to be viewed

in each segment. Click on a segment and press the corresponding camera button to be

displayed.



Audio Control

The DV-IP supports bi-directional communication. The audio controls allow audio connections to

be established between the PC application and the DV-IP device allowing live audio to be

transmitted/received. These controls are also enabled in playback mode if audio has been

recorded alongside the video, the Operator can then use the speaker buttons to hear the audio

while reviewing the video images.

The audio buttons can be momentary or latched. To select momentary control press the relevant

audio button using the left mouse key, pressing and holding will keep the button enabled. To

select latched control press the relevant audio button using the right mouse key, the button will

remain latched until selected again.

Freeze on a Single Image

It is possible to use the VCR pause button in live mode to freeze the image that is being

displayed. This allows an Operator to view in more detail the frozen image to determine if an

incident is occurring.

Freezing the live video will not affect the recorded images.

Save/Load a View

It is possible to save a View, the viewer will remember the images that are being displayed when

the view is saved and also the location if a multiscreen is selected. This view can then be

selected at a later time and the images will be automatically displayed in the correct location.

To save a View press <Ctrl + S>, enter the name and

location where the view will be saved.

To load a View press <Ctrl + L> and select from the list

for the relevant View. The View will be automatically

displayed.
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Note: To select a latch button use the left mouse key to switch the function off.



Live Mode Controls

These are the controls that are available when controlling images from the DV-IP video server in

Live mode operation.

PTZ Control

It is possible to select and control any of the cameras connected to the video inputs on the DV-

IP Server, if any of these cameras are functional PTZ or dome cameras then this control

includes PTZ functionality, such as pan, tilt, zoom, focus, auxiliaries and goto preset position.

Zoom control – zoom in on an object, zoom out for full view

Focus control – focus on an object close to the camera (near), focus on an object

in the distance (far)

Iris control – open iris to let more light into the image, close iris to reduce the

amount of light

Autopan – automatically move the camera between two pre-defined preset

positions

Auxiliary control – wash the glass on the camera housing, wipe any water from the

glass on the camera housing, switch lamps on and off, ……….

Numeric keypad – This is used in conjunction with presets and patrol mode and

allows the relevant number to be selected
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Patrol Mode – A patrol mode can be stored within the PTZ/dome camera. Select

the patrol number from the numeric keypad and then the patrol key

Pan and tilt control – move the camera by using the pan and tilt buttons, the arrow

shows the direction the camera will move

MPEG4/MJEPG - The DV-IP video server can transmit either MPEG or MJPEG

video images, it is possible within the viewer to switch between the two

compressions.

Important Information

It is possible to use VMD (Video Motion Detection) on moveable cameras, however to ensure

that moving the camera does not trigger false alarms the VMD will only be active when the

dome is in preset position 1 (home position). This ensures that VMD is only active when the

camera is viewing the field of view that the VMD mask corresponds to, moving the camera away

from preset 1 will automatically inhibit VMD detection on the camera. As soon as the camera

receives the command to ‘return to home’ the VMD will be automatically re-enabled.
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Note: This button can be removed in the Options menu, this is recommended if MPEG4 compression is

not being used so the Operator does not accidentally switch between the two options.

Note: It is necessary for the ‘return to home’ command to be issued so that the DV-IP Server is aware the

camera is back at preset position 1, leaving the camera to return to preset 1 after a dwell time will not be

sufficient to re-enable the VMD functionality.



Playback Mode Controls

In playback mode it is possible to use the VCR keys to control the images being reviewed.

There are a number of options available when playing back a video image;

Play - playback the video from the camera selected or highlighted an alarm file

Fast rewind - move quickly back through the recorded video

Fast forward - move quickly through the playback video

It is possible to increase the speed of the video in playback mode. When fast

forward or rewind have been selected, the speed of the video can be increased by

up to 1000 times the normal speed by selecting one of the options from the drop

down list.

Pause - stop the video on a particular image. 
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Note: When paused the Rewind and Fast Forward buttons change to frame back and frame forward.



Miscellaneous Controls

There are a number of additional features of the DV-IP Viewer 2 that can be used to enhance

the Operator control as described above.

Event List

The DV-IP logs every event (as configured in the web configuration pages) to an event

database. It is possible to download the information from the DV-IP unit to the Viewer to review

the list and select any associated files to playback the recorded images.

When the Event List button is selected the event list will be displayed as an

additional tab on the viewer allowing you to switch between the event list and live

view.

Previous                         Next

Using the previous and next buttons allows you to step through the events. If an event exists

(has an associated file still stored on the DV-IP) when this file is highlighted the associated video

image will automatically be displayed. The previous and next buttons will then move you to next

image in the event list.

Download Images

It is possible to select a time period and download all associated images to the local

PC. These files can then be played back using the DV-IP Viewer 2, refer to Replay

Server section below.
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MJP file                                     VID/IDX Files

When you select the download key you will be presented with the Download screen. You will

need to identify the file type, time and date (either ‘to’ and ‘from’ or ‘from’ and ‘for’), cameras that

are to be included in the download and the file name and location. Select Download to

download the images.

The VID/IDX images can be reviewed using the DV-IP Viewer in Replay Server mode, refer to
the Additional Functionality section below.
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Note: If VID/IDX is selected it will be necessary to enter the User name and Password for creating an FTP

connections from the PC to the DV-IP device.



Replay Server

The DV-IP Viewer can be used as a replay server to allow recorded images (that have been

downloaded from a DV-IP unit to the local hard drive or are stored on a removable hard drive) to

be played back through the viewer application without the need to connect directly to a DV-IP

device.

Selecting this option presents a configuration screen to allow you to select where the stored

images are located. 

1. Select the source type (Removable HDD or Downloaded files)

2. Select the directory where the images are, use the buttons to locate the files.

Go up one level

Select desktop

Create a new folder

List information
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Additional Functionality

Note: If a removable hard drive is to be reviewed this must be connected prior to selecting this option.



Show details on files

3. Enter the necessary information in the Additional Information section. Enabling debug will 

automatically show the debug window. Enter the TCP port that the connection will be 

made, the default port number is 80.

4. Click OK, the DV-IP viewer will locate the files.

5. The Viewer now needs to be instructed to connect to the ‘local drive’ of the PC to allow the

images to be reviewed, this can be achieved in one of two ways

a. Enter ‘localhost’ in the address and click Connect

b. Enter ‘127.0.0.1’ in the address and click Connect

A camera fail image will be displayed.

6. Select Play or Rewind for the recorded images to be displayed. You will now have the 

standard playback controls.
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Note: The Replay Server emulates the replay functions of a DV-IP Server. Once the replay server is

started other PC’s running DV-IP Viewer can also connect to that PC to view recorded images.



Display Options

There are a number of screen displays supported within the viewer, any of these can be

selected from the drop down list.

The following shows the screen displays along with the default camera positions when the

associated display option is selected.

Single image                           4 Way                                    9 Way    

16 Way                                   4 (TL) plus 3                           4 (TR) plus 3    

4 (BL) plus 3                            4 (BR) plus 3                          8 Plus 2 (TL/TR)               

8 Plus 2 (BL/BR)                      8 Plus 2 (TL/BL)                     8 Plus 2 (TR/BR)

12 Plus 1 (TL)                          12 Plus 1 (TR)                       12 Plus 1 (BL)    

12 Plus 2 (BR)                         P in P (TL)                             P in P (TR)                        

P in P (BL)                               P in P (BR)                            4 Way P in P (TL)

4 Way P in P (TR)                    4 Way P in P (BL)                   4 Way P in P (BR)
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Appendix A
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NSW 2154
Australia
Tel: +612 9634 4211
Fax: +612 9634 4811

DDeeddiiccaatteedd  MMiiccrrooss,,  AAssiiaa  PPTTYY

16 New Industrial Road, 
#03-03 Hudson Techno Centre,
Singapore 536204
Tel: +65 62858982
Fax: +65 62858646

DDeeddiiccaatteedd  MMiiccrrooss  MMiiddddllee  EEaasstt

Building 12, Suite 302,
P.O. Box 500291, Dubai Internet City,
Dubai, United Arab Emirates
Tel: +971 (4) 390 1015
Fax: +971 (4) 390 8655

DDeeddiiccaatteedd  MMiiccrrooss  (PMMaallttaa))  LLttdd..

UB2 San Gwann Industrial Estate,
San Gwann SGN 09 Malta
Tel: +356 21483 673
Fax: +356 21449 170
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